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Regional Sediment Management (RSM) Demonstration Program Technical Note

 

Regional Morphology Analysis Package (RMAP): 
Part 1.  Overview 

 

PURPOSE This Regional Sediment Management (RSM) Technical Note 
describes the Regional Morphology Analysis Package (RMAP), an 
integrated set of tools developed for manipulating, analyzing, 
visualizing, and archiving data on shoreline positions and beach 
profiles in a georeferenced environment on a personal computer.  
Information can be referenced to and displayed on aerial 
photographs and maps.  Developed to support regional as well as 
local project studies, data types and analysis procedures are 
applicable to coasts, estuaries, and rivers.  This technical note 
provides an overview of RMAP.  Future technical notes in the 
RMAP series will describe specific features and new capabilities. 

BACKGROUND RMAP evolved from the Beach Morphology Analysis Package 
(BMAP) (Sommerfeld et al. 1993, 1994; Wise 1995), which was 
conceived to simplify and automate numerical modeling work 
flow and associated analysis of beach profile data and results of 
computations from the Storm-induced BEAch CHange model 
(SBEACH) (Larson and Kraus 1989; Larson, Kraus, and Byrnes 
1990).  Although BMAP provides a robust toolset for profile 
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analysis, it is limited to data in distance-elevation space.  BMAP 
requires the user to discard the geospatial aspect of profile data, 
essential in data assembly and quality control.  Regional analysis 
requires manipulation of another type of two-dimensional (2-D) 
data, the shoreline, which is georeferenced.  Numerical simulation 
models under development in the Regional Sediment Management 
(RSM) Program involve manipulation of data and corresponding 
outputs in a georeferenced coordinate system, often over wide 
geographic areas and different coordinate systems.  These and 
other U.S. Army Corps of Engineers’ needs identified at a field-
data collection workshop were the stimulus for creation of RMAP. 

 Typically, analysis of beach profile and shoreline position data 
requires several software packages.  On the other hand, the 
engineering and numerical modeling work environment calls for 
tools directly supporting workflow from the original surveys to 
quality control, analysis, and input to a project report or model.  
RMAP contains a comprehensive set of analysis and visualization 
tools required for project workflow, from the import of raw data 
and coordinate conversion through detailed analysis to report-
quality graphics.  RMAP supports analysis of beach profile, 
channel or river cross-sectional data, and shoreline position data 
for engineering and science applications.  Capabilities extend from 
generation of spatially referenced shoreline change maps to a large 
suite of beach profile analysis tools.  Data can be examined in both 
cross-sectional and map views to simplify data assembly, quality 
control and assurance, data analysis, and generation of report 
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figures.  The map viewer supports the display of profiles, 
shorelines, aerial imagery and ArcView® shapefiles in a 
geospatial environment.  Data options allow storage, organization, 
and analysis of data in a single application, with support for a 
variety of import/export formats.  Chart options allow tailoring of 
graphics to personal needs, supporting export of images and direct 
copy and paste into word processing software.  Metadata can be 
stored at project, group, or individual data item levels.  RMAP is 
backwards-compatible with BMAP project files and supports 
calculation of geographic coordinates from reduced distance-
elevation data pairs. 

 This technical note summarizes present capabilities of the RMAP 
software.  Planned work in the RSM Program will add routines to 
RMAP for analyzing and visualizing three-dimensional (3-D) (X, 
Y, Z) data, where X and Y denote horizontal coordinates, and Z 
denotes the vertical coordinate.  In addition, the final version will 
include relational database capability to archive and access large 
data in space and time that are often encountered in RSM 
applications. 

RMAP Interface RMAP runs in the Microsoft Windows® environment and requires 
computer resources available on typical personal computers.  The 
RMAP interface comprises four main features (Figure 1). 

a. File menu and toolbar.  Data import/export, analysis 
functions, and viewer controls are accessed through the file 
menu and toolbar.   
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b. Data tree.  The data tree displays data items present in the 
software package and allows selection of multiple items for 
batch conversion or analysis.  

c. Graph/map viewer.  The graph/map view window supports 
visualization of data by cross section in graph mode and 
plan view in map mode.   

d. Data Table.  The data table allows the user to view and edit 
data for each item in the data tree.  This area also stores the 
time stamp of the data entry and allows the user to store 
comments on each item in the data tree. 

 File menu and toolbar 
The RMAP file menu provides access to functions common in 
Windows applications (such as Save, Open, etc.), and those 
functions unique to RMAP, such as graph controls, data grid 
functions and profile and shoreline analysis tools.  Many functions 
can also be accessed from the RMAP toolbar, where they are 
grouped by functionality (Figure 2).  Functions unique to RMAP 
are discussed here.   

Items under the File menu support import/export of project data 
from ASCII text files or the RMAP free format.  The RMAP free-
format allows users to import entire data sets at once, or archive 
RMAP projects into an ASCII text file that can be accessed by 
spreadsheet applications or text viewers.  The Edit menu allows 
access to data management functions for the data tree, project  
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options and settings.  Multiple items in the data tree can be moved, 
copied or deleted using the item checkboxes and the command 
under the menu.  Also, coordinate conversion for single or 
multiple items is performed here.  For beach profiles, tools are 
provided to calculate distance D from the transect origin (X, Y to 
D) or to calculate geographic coordinates from a transect origin 
along an azimuth (D to X, Y).  The project options dialogue allows 
the user to specify the project units, store project metadata and 
name the project.  The View menu allows the user to toggle the 
toolbars, status bar, and data table on or off.   
Items in the data tree can be sorted by date or name 
(alphanumeric).  The Group menu allows the user to add or delete 
groups or data tree items.  This is also accomplished by right-
clicking the mouse in the data tree.  The Graph menu accesses 
options for the graph control.  The graph appearance is 
customizable by the user, including background colors, line colors, 
width, axes scaling, etc.  This menu also allows the user to export 
beach profile data plotted in the graph view to SBEACH.  Future 
export options will include output to the GENESIS and 
CASCADE models, and to the Sediment Budget Analysis System 
(SBAS).  The Table menu allows the user to insert and delete rows 
in the data table, as well as write protecting data.  The Analysis 
menu contains analysis tools and algorithms for beach profile  
and shoreline data.  These tools are discussed in the following  
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paragraphs.  Finally, the Help menu provides user support and 
access to documentation on the analysis routines. 

 Data tree 
Data are managed and selected for analysis in the data tree.  The 
data tree in RMAP displays and organizes project data into three 
categories: beach profiles, shorelines and baselines, each identified 
by a unique icon (Figure 3).  Data can be brought into RMAP by 
importing from ASCII text or RMAP free format, copying and 
pasting from spreadsheet applications, converted from ArcView® 
shapefile format (shorelines and baselines only), or entered into 
the data table by the user.  Data tree entries are generated and 
named automatically when importing profile, shoreline, or baseline 
data into RMAP from ASCII text.  In copying and pasting data 
into RMAP, data tree entries must be created first and then 
renamed by the user.   
Items can be arranged into groups and subgroups under the Project 
menu.  Data items can be sorted by date or name, or manually 
sorted by the user by dragging and dropping in desired order.  
Metadata settings include origin location and transect azimuth for 
profiles and definition for shorelines (e.g., as the high-water line 
(HWL), wetted bound, other; see Kraus and Rosati (1998) ).  A 
data item is plotted in the graph/map viewer and made available 
for analysis by activating the selection box beside the data type 
icon.  The selection box also provides a means of copying, pasting, 
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moving, and deleting multiple data items in the tree.  In addition, 
selection boxes are used to conduct analysis functions, coordinate 
conversion, and distance calculations for multiple items.   

 Graph/map viewer 
The graph/map viewer provides visualization of both profile and 
shoreline data in graph (cross-section) or map (plan) views.  The 
window is toggled between the two views by means of the RMAP 
toolbar (Figure 2).  Data are plotted in the viewer by activating the 
selection box next to the item.  In graph view, a typical cross-
section plot is generated in the viewer (Figure 4).  The plot legend 
is automatically generated on the plot as data are added.  Plot axes 
adjust to the full extent of plotted data; however, the user can 
manually set the axis extent.  The user can zoom into areas of 
interest and pan around the viewer to investigate data.  Data values 
in the view automatically refresh as the data table is edited.  The 
user has full control over graph appearance with the options 
available under the Graph menu. 

 The map view allows visualization of spatially referenced profile, 
shoreline and baseline data, in addition to georeferenced aerial 
photography and ArcView® shapefiles.  The ability to view data in 
plan view overlaid with ground imagery assists with data 
assembly, quality control, and data analysis.  Each item is labeled 
according to the object name in the data tree as it is added to the 
view.  Labels, feature items, and legends can be edited individually 
or as a group.  The display properties of all items in the map view 
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can be customized to individual preferences in the map properties 
dialogue (Figure 5). 

RMAP supports a variety of geographic and projected 
coordinate systems, including North American Datum (1927 and 
1983), Geographic Coordinate Systems, U.S. State Plane, 
Universal Transverse Mercator, and World Geodetic System 
coordinates, in addition to many other systems in use worldwide.  
Units can be in either feet or meters.  The user selects the project 
coordinate system in the map view properties; all data imported 
into RMAP can be then be converted to the project datum from 
within the application (Figure 6).  Once the conversion is 
complete, the data table is refreshed with the new coordinates, and 
the conversion is recorded as metadata in the “Notes” section of 
the data table (Figure 7). 

Shoreline analysis is directly supported in the map view.  
RMAP allows the user to calculate change rates between two 
shorelines from a user-defined baseline.  Shoreline analysis 
transects are established perpendicular to the baseline at a user-
specified interval, and then shoreline change and change rates can 
be calculated at each transect along the baseline.  Shorelines and 
baselines can be imported from text, converted from ArcView® 
shapefiles, or drawn in the map viewer.  Tools are provided to 
allow the user to annotate shoreline position on a photograph, 
creating a georeferenced shoreline entry in the data tree upon 
completion.  After shoreline analysis is complete, RMAP 
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generates an analysis report (Figure 8), a spatially referenced 
shoreline change map (Figure 9), and a shoreline change rate plot 
in graph mode (Figure 10).   

Profile data are also projected in the map view, simplifying the 
creation of base maps, easing data assembly, and streamlining 
quality control of data.  As profile data are plotted, a color map 
elevation gradient is generated along the profile line to allow  
the user to distinguish shallow and deep portions of the profile 
(Figure 11).  Profile overlap, distance off the transect azimuth,  
and the overall goodness of fit of the data are easily evaluated  
by switching back and forth between map and graph modes 
(Figure 12).  Ready availability of map and graph modes makes 
convenient the translation or shifting of data, because results can 
be easily evaluated in both cross-section and plan views. 
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 Data table 
The data table allows the user to view and edit the time stamp, 
coordinate, elevation and distance values for each item in the data 
tree (Figure 13).  A “Notes” Window is also provided to allow 
storage of metadata for individual items.  Data in the grid are 
edited in a fashion similar to standard spreadsheet applications.  
Formats for the different data types are described in the following 
paragraphs. 
For beach profile data, the grid contains four columns: geographic 
horizontal coordinates (X and Y), elevation (Z), and distance (D).  
Tools are provided in the data grid for calculation of distances 
along the transect from the geographic coordinates, in addition to 
calculation of the geographic coordinates from distance elevation 
pairs given profile origin coordinates and transect azimuth.  
Consideration was given for accommodating BMAP project files 
while implementing RMAP coordinate capabilities.  BMAP data 
columns (distance/elevation pairs) are automatically assigned to 
the Z and D columns upon opening.  In addition, data are assigned 
to different columns depending on the number of columns present:  
pasting two columns places data in the D and Z columns; pasting 
three columns places data in the X, Y and Z columns; or pasting 
four columns places data X, Y, Z, and D columns.  Shoreline and 
baseline data types have three data columns: geographic horizontal 
coordinates (X and Y) and elevation (Z), though in the case of 
baseline data, the Z column is not applicable. 
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Shoreline Analysis 
Tools 

Shoreline change 
Calculates shoreline change rates between two shorelines.  
Generates report including average, minimum and maximum 
change and change rates and time span of analysis.  Generates 
shoreline change graph (graph mode) and a spatially referenced 
shoreline change map. 

 Shapefile convert 
Converts ArcView® shapefiles into RMAP shoreline or baseline 
data items in the data tree. 

 Draw shoreline/baseline 
Allows the user to digitize a georeferenced shoreline or baseline in 
the map viewer and creates a new item in the data tree. 

 Combine shoreline 
Combines adjacent shoreline segments in order of increasing 
easting distance.  Generates new entry in the data tree. 

 Interpolate shoreline 
Resamples the shoreline at a user-specified interval and generates 
a new item in the data tree.   
Smooth shoreline 
Uses a running average of points to smooth a shoreline.  User can 
specify number of points.  Generates new entry in the data tree.  
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 Mean shoreline 
Calculates an average shoreline position for a series of selected 
shorelines, generates new item in the data tree.   
Shoreline statistics 
Calculates the number of points, variance, standard deviation, and 
minimum and maximum distances of a shoreline from the 
baseline. 

Beach Profile 
Analysis Tools 

RMAP includes a diverse set of tools for analyzing beach profile 
data.  RMAP generates a report for each analysis, which can be 
exported as text, printed, or copied to the clipboard.  Functions and 
analysis routines are described in the following text. 

 Bar properties 
Bar properties are analyzed in RMAP by drawing a selection box 
around the bar form.  Although defining a bar feature visually may 
be subjective, negligible differences in bar volume typically result 
from this method if done by an experienced user.  Bar volume, 
length, center of mass, minimum depth and location, and 
maximum depth and location are reported.    
Profile comparison 
The profile comparison routine calculates the volume and contour 
location change for two profiles within a user-defined area.   
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 Cut and fill 
This routine compares two profiles and defines cells defined by 
intersections between the two profiles.  The analysis report gives 
beginning and volume change is calculated for each cell.  Total 
volume change, volume change above and below the vertical 
datum, and shoreline change at the datum are also calculated. 

 Horizontal alignment 
The horizontal alignment routine translates profiles an arbitrary 
distance to horizontally align all selected profiles to the user-
specified elevation contour.  
Least square estimate 
Estimates the A-parameter and median grain size (d50) over a user-
specified extent of a cross-sectional beach profile.  Provides 
correlation coefficient (r2) for the solution.  
Volume and sectional volume 
Calculates the volume of a beach profile above a user-specified 
elevation contour and/or to a user-specified spatial extent.  Reports 
volume and contour location.  The algorithm will interpolate 
profiles or modify analysis bounds if profile extent does not meet 
the analysis extent.   
Transport rate 
Calculates the cross-shore transport rates for a time period at user-
specified interval between two succeeding profiles.  Plots the  
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cross-shore transport rate and reports maximum and minimum 
rates, as well as the rate at the most seaward point of the pair or 
profiles. 

 Average 
Calculates, plots, and generates new items under the data tree for 
the average, maximum and minimum profiles.  The standard 
deviation for the analyzed profile is plotted on the graph.     
Interpolate 
Interpolates the profile at a user-specified interval.  Generates a 
new profile under the data tree. 
Translation 
Allows the user to translate profiles vertically or horizontally (or 
both).  Horizontal translations can be applied to the X and Y 
coordinates if the profile is in geographic space.   
Combine profiles 
Combines selected profiles.  Profiles are selected using the check-
box in the data tree, then combined in order of ascending distance 
or horizontal (X) coordinate values.  A new profile is generated 
under the data tree upon completion. 

 Synthetic profiles 
RMAP allows the user to generate several types of synthetic 
profiles, including beach-fill templates, equilibrium profile (Dean 
1991) and modified equilibrium profile (Larson 1991), 
interpolated profiles, and plane sloping profiles. 
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 Depth of closure calculation (Beach-fill module) 
Estimates the depth of closure (Kraus, Larson, and Wise 1998) 
calculated by the Hallermeier (1978) equation for local significant 
wave height exceeded in a 12-hr interval, or through the mean 
annual significant wave height for a coastal area. 
Erosion/accretion predictor (Beach-fill module) 
Predicts erosion or accretion based on the sediment fall speed 
parameter for either deep water or finite depth based on equations 
in Kraus, Larson, and Kriebel (1991).   
Planform evolution model (Beach-fill module) 
The planform evolution model provides an estimate of the 
alongshore redistribution of beach nourishment material resulting 
from the interaction between the fill material and wave conditions 
at the fill site.  The model embraces concept of background 
erosion in the prediction of shoreline change and has the capability 
to impose the effect of a user-specified rate of background erosion.  
Methodology is based on Dean and Grant (1989). 

Product 
Development and 
Availablitiy 

The RSM Program develops products to support engineers in the 
work force.  Improvements or additions to RMAP are dependent 
on user comments.  Please forward comments and suggestions to 
RMAP point of contact listed in the following section. 
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POINT OF 
CONTACT 

This RSM Technical Note was written by Dr. Brian K. Batten, 
research physical scientist and by Dr. Nicholas C. Kraus, Senior 
Scientist, Coastal and Hydraulics Laboratory, Vicksburg, MS,  
U.S. Army Engineer Research and Development Center. The  
work described herein was supported by the National RSM 
Demonstration Program. Questions about this technical note can 
be addressed to Dr. Batten (601-634-4653, Brian.K.Batten@erdc. 
usace army.mil. Dr. Jack E. Davis (601-634-3006, 
Jack.E.Davis@erdc. usace.army.mil) and Ms. Julie D. Rosati 
(601-634-3005, Julie.D.Rosati@erdc.usace.army.mil) are RSM 
Program Managers. The RSM Web site 
(http://www.wes.army.mil/rsm) gives additional information. 
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Figure 1. The RMAP interface is comprised of (1) file menu and toolbar, (2) data tree,  

(3) graph/map viewer, and (4) data table 
back to text 
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Figure 2. RMAP toolbar is organized by file/program functions, zoom controls, Beach Fill Module tools,  

profile analysis, shared profile and shoreline tools, shoreline tools and analysis, and map tools 
back to text 
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Figure 3. RMAP provides for three types of items in data tree: profiles, shorelines, and  

baselines.  Unique icon in tree identifies each type 
back to text 
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Figure 4. Example of cross-section plot of beach profile data in RMAP.  Data legend is generated 

 automatically as data are added to plot.  Plots can be copied directly from RMAP into word 
 processing applications 

back to text 
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Figure 5. RMAP allows extensive customization of visual properties of all items featured in map view.   

Figure illustrates available options for shoreline change maps 
back to text 
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Figure 6. Beach profile, shoreline and baseline coordinates can be converted to project coordinate system  

within RMAP using coordinate conversion dialogue box 
back to text 
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Figure 7. Coordinate conversions are recorded under items notes, located in data table 

back to text  
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Figure 8. Shoreline change report.  Average, minimum, and maximum shoreline change and change rates  

are given 
back to text  
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Figure 9. Spatially referenced shoreline change rate map for eastern shore of Maryland showing erosion  

downdrift of Ocean City Inlet 
back to text  
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Figure 10. Traditional shoreline change rate plot is available in graph mode. 

back to text  
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Figure 11. Profile data plotted in map view with georeferenced aerial photography in background 

back to text  
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Figure 12. Map view allows investigators to view profile data in plan view, simplifying project data assembly  

and quality control of successive survey data 
back to text  
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Figure 13. The data table in RMAP allows user to edit items in spreadsheet format and store documentation  

relating to individual items 
back to text 


